
 
 

Introduction to Information Technology 
 

Assessment of Fundamental Competencies  
Model Paper  50 marks – 1 hour 30 minutes 
  
 

Instructions to Candidates: 
(i) Select the most appropriate answer from the options available for each question.  
(ii) There will be no negative marking for incorrect replies.  
(iii) Each question is of one mark.  
  

  
1.  Which of the following statements about operating system is correct?  

 (a)  It controls the operation of all software including application software.  
 (b)  It provides systems security.  
 (c)  It provides the graphical user interface between the user and the computer.  
 (d)  All of the above.  

  
2.  The main purpose of the secondary storage device is to:  

 (a) increase the speed of computer (b) take backup  
 (c) share the data on networking (d) store data  
  

3.  If you want every student to input his roll number and scan his finger for attendance, you 
need to have a combination of:  

 (a)  Keypad, Mouse, OCR Scanner and Monitor  
 (b)  Touch Screen and Biometric Scanner  
 (c)  Touch Screen and Keypad  
 (d)  Mouse, Monitor and Biometric Scanner  
  

4.  Which of the following DOS commands will display the IP address of your computer?  
 (a) comp_ip (b) ip_config (c) ipconfig (d) configip  
  

5.  In MS Windows, which of the following utility programs provides most appropriate way of 
deleting unnecessary files and freeing up space on the hard disk?  

 (a) Disk defragmenter (b) Task manager (c) Disk cleanup (d) Check disk  

  
6.  Which of the following syntaxes is correct for using VLOOKUP in MS Excel?  

 (a) VLOOKUP(table_array, col_index_num, [range_lookup])  
 (b) VLOOKUP(lookup_value, table_array, col_index_num, [range_lookup])  
 (c) VLOOKUP(lookup_value, table_array, row_index_num, [range_lookup])  
 (d) VLOOKUP(row_value, table_array, col_index_num, [range_lookup])  
  

7.  The maximum number of IF functions that can be nested as value_if_true and value_if_false 
arguments is:  

 (a) 4 (b) 16 (c) 32 (d) 64  
  

8.  In an MS Excel worksheet when you subtotal a horizontal range such as 
SUBTOTAL(109,A2:K2,A3:K3) then in the given range hiding any:  

 (a) column or row will not affect the subtotal  
 (b) column will not affect the subtotal but hiding a row will affect the subtotal  
 (c) row will not affect the subtotal but hiding a column will affect the subtotal  
 (d) column or row will affect the subtotal  
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9.  In an MS Excel worksheet you can display $ symbol with numeric values automatically if you 

select the number format:  
 (a) Accounting only (b) Currency only  
 (c) both Accounting and Currency simultaneously (d) either Accounting or Currency  
      

10.  In an Excel worksheet, age of employees is stored in column B and their annual earning is 
stored in column C. Which of the following formula will give the number of employees who 
are more than 40 years old and have earning of Rs. 600,000 per annum or more?  

 (a) =COUNTIFS(B2:B101,">=40",C2:C101,">=600,000")  
 (b) =COUNTIFS(B2:B101,">40",C2:C101,">=600,000")  
 (c) =COUNTA(B2:C101,"B2:B101>40",C2:C102,">600,000")  
 (d) =COUNTA(B2:B101,">40",C2:C101,"=600,000")  
    

11.  In MS Excel, the sequence of steps to show/hide the gridlines is:  
 (a) Page Layout >> Sheet options>> Gridlines >> View  
 (b) View >> Show >> Gridlines   
 (c) Home >> Font >> Borders >> No Border   
 (d) Both (a) and (b)  
  

12.  In MS Excel, the keyboard shortcut to insert current date in a cell is:  
 (a) CTRL + D (b) CTRL + T (c) CTRL + ; (d) CTRL + /  

  
13.  In conditional formatting feature of MS Excel, we can:  

 (a) use a formula to determine which cells to format  
 (b) format values that are above or below average  
 (c) format unique or duplicate values  
 (d) all of the above  

  
14.  Which of the following statements regarding protection of an MS Excel worksheet is correct?  

 (a) Locking cells or hiding formula has no effect until you protect the worksheet  
 (b) Locking cells or hiding formula is effective as soon as you apply it  
 (c) A worksheet can be protected only if you apply hiding formula option  
 (d) A worksheet is protected automatically if you apply hiding formula option  
    

15.  Which of the following statements regarding shared MS Excel worksheet is NOT correct:  
 (a) You can merge any two cells  
 (b) You can remove personal information from it  
 (c) You cannot remove comments from it  
 (d) Both (a) and (b)  
  

16.  In an MS Excel workbook:  
 (a) you cannot save a worksheet as a web page  
 (b) you can have different personalized header and footer for different worksheets of the 

same workbook  
 (c) you cannot insert comments on each cell  
 (d) you cannot protect a worksheet and still share it with others  
  

17.  An MS Excel worksheet contains data spread over 10 columns and a number of rows. On 
print preview, it is observed that one column and a few rows are out of page boundary.  The 
quickest way of adjusting the data on one page is to:  

 (a) adjust margins in Page Setup  
 (b) print it on a slightly bigger size of paper  
 (c) view and adjust page size in Page Break Preview  
 (d) set print area in Page Layout  
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18.  In MS Excel, if the number format of a cell has been customised to “+##-42-####-####” and 

12345678 is entered in the cell, it will be displayed as: 
 

 (a) +12-42-3456-78 (b) 42-1234-5678  
 (c) +12-42-3456-78## (d) +-42-1234-5678  
      

19.  The most efficient way to increase the readability of large numeric values stored in a particular 
column of an MS Excel worksheet is to select the column and then: 

 

 (a) go to Format Cells: Number>> Select category Number>> Check ‘use 1000 separator’ >> 
OK 

 

 (b) apply Bold font format  
 (c) apply Comma Style  
 (d) go to Format Cells: Number >> Select category custom>> Type: ###,###.00 >>OK  
    

20.  If you unprotect a protected worksheet in MS Excel and later close the workbook  after making the 
desired changes then the next time when you open that workbook: 

 

 (a) the worksheet will open as protected sheet  
 (b) the worksheet will open as unprotected sheet  
 (c) the worksheet will not reflect the changes made by you  
 (d) will contain two copies of the worksheet, i.e. the modified worksheet and the original 

protected worksheet 
 

    

21.  Which of the following statements is correct regarding ‘hide’ feature of MS Excel?  
 (a) You can hide more than one worksheet  
 (b) You can hide an entire workbook without actually closing it  
 (c) Both (a) and (b)   
 (d) You cannot hide more than one worksheet  
    

22.  MS Excel can import data from which of the following sources:  
 (a) XML file (b) MS Access Database  
 (c) SQL Server Analysis Services cube (d) All of the above   
    

23.  Correct sequence of creating a new template in MS Excel is:  
 (a) File (tab) >> Publish >> Type Excel Services >> File name >>  Save as Type >> Excel 

Binary Workbook >> Save 
 

 (b) File (tab) >> Save as >> Type File name with extension tmp) >> Save  
 (c) File (tab) >> Save as >> Type File name >> Save as Type >> XML Data >> Save  
 (d) File (tab) >> Save as >> Type File name >> Save as Type >> Excel Template >> Save  
    

24.  Using templates in MS Excel, you can:  
 (a) hide your workbook in a temporary folder  
 (b) create new workbooks with user defined fonts and background of worksheets  
 (c) perform repeated tasks automatically  
 (d) store formats of most frequently used worksheets  
    

25.  In MS Excel, a custom number format is:  
 (a) stored in the workbook in which it was created and is available to all sheets of the workbook  
 (b) stored in the worksheet in which it was created and is not available to other sheets of the 

same workbook 
 

 (c) removed automatically from all places once you close the workbook in which it was created  
 (d) both (a) and (c)  
  

26.  In MS Word, the ‘Widow/Orphan control’ prevents:  
 (a) a paragraph to begin on the last line of a page  
 (b) a page to begin with only the last line of a paragraph from the previous page  
 (c) a paragraph to break across multiple pages  
 (d) both (a) and (b)  
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27.  In MS Word, a section break once inserted can be removed by simply placing the cursor:  

 (a) before the section break and pressing the delete key twice in Web Layout view  
 (b) before the section break and pressing the delete key twice in Outline View  
 (c) on the section break and pressing the delete key twice in Draft View  
 (d) both (b) and (c)  
    

28.  In MS Word, ‘convert text to table’ feature converts the selected text into a table, by splitting the 
text into columns at each:  

 (a) line break  
 (b) section break  
 (c) word beginning with upper case  
 (d) commas, tabs, paragraphs or any other character you specify  
  

29.  In MS Word, you can sort a list of names if it is:  
 (a) stored in a table  
 (b) numbered using ‘Numbering’ feature  
 (c) simply typed in the document  
 (d) all of the above  

  
30.  In MS Word, the Design and Layout tabs in Table Tools:  

 (a) are visible in all MS Word documents whether such documents contain a table or not  
 (b) remain visible in the MS Word document that contains at least one table  
 (c) are activated only when a table is selected  
 (d) both (a) and (b)  

  
31.  In MS Word, if you modify the style of a table in a Normal Template then the:  

 (a) modified style will automatically be applied to all tables in the document  
 (b) modified style cannot be applied to other tables   
 (c) modified style will be applied to the selected table and can be applied to existing as well as 

new documents which are based on the Normal Template 
 

 (d) modified style will be applied to the selected table and can be applied to all the new 
documents based on the Normal Template 

 

  
32.  In MS Word, Table of Contents is created by:  

 (a) using the built-in heading styles  
 (b) applying the font size and style from Font group on the Home tab  
 (c) using table Style Options in the Table Tools Design tab  
 (d) both (a) and (b)  

  
33.  In MS Word, a footnote can be inserted from the:  

 (a) Footnotes group on the Reference tab (b) Links group on the Insert tab  
 (c) Header & Footer group on the Insert tab (d) both (a) and (b)  

  
34.  In MS Word, Endnote can be:  

 (a) converted to footnote  
 (b) swapped with footnote  
 (c) placed at the end of the document  
 (d) all of the above  

  
35.  In MS Word, which of the following is NOT a ‘Section Break’ option?  

 (a) Next Page (b) Previous Page (c) Odd Page (d) Even Page  

  
36.  In MS Word, ‘Watermark’ as page background is NOT visible in:  

 (a) Web Layout View (b) Full Screen Reading  
 (c) Outline View (d) All of the above  
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37.  You have copied a large text in an MS Word file. You cannot keep this text on the Office 

Clipboard after you:  
 (a) exit from MS Word application (b) lock the computer  
 (c) log off from the computer (d) paste it somewhere  

  
38.  Sohail has emailed you a 25 page report in MS Word with a request to review and highlight 

the changes in the report. The most efficient way to accede to Sohail’s request is to:  
 (a) save the file with a different name, make changes  and email him the new document 

with the advice to read both old and new documents for changes 
 

 (b) make changes and highlight them with bold font style  
 (c) write your changes in a new file and cross refer the changes using track changes feature  
 (d) turn on track changes feature before making changes  
    

39.  In MS Word, which of the following combination of special text effects may be applied 
simultaneously on a particular text?  

 (a) Glow and Reflection  
 (b) Outline and Shadow  
 (c) Shadow and Reflection  
 (d) All of the above  
    

40.  In MS Word, the keyboard shortcut to display font dialog box is:  
 (a) Ctrl + D (b) Ctrl + Shift + F  
 (c) Ctrl + Shift + P (d) All of the above  
  

41.  In MS PowerPoint, ‘design themes’ are used to:  
 (a)  change the overall design of a particular slide  
 (b)  add functionality to a particular slide  
 (c)  change the look and transition of all the slides  
 (d)  change the overall design of all the slides  
  

42.  To select slide no. 7 and 32 in a PowerPoint presentation, you need to:  
 (a) just click on both slides (b) Ctrl + Click on both slides  
 (c) Alt + Click on both slides (d) Shift + Click on both slides  
  

43.  In MS PowerPoint, the ‘Rehearse Timing’ is:  
 (a)  the increase in the time that a presentation takes to run after applying a theme  
 (b)  the decrease in the time that a presentation takes to run after removing all transition 

effects  
 (c)  the time that a presentation takes to run if advance slide option is set to 1.0 second  
 (d)  the recorded time after which next slide would appear automatically during the 

slideshow  
  

44.  In a PowerPoint presentation:   
 (a)  a Table can be inserted from Insert menu  
 (b)  a Table can be inserted by clicking on Insert Table in content pane of a new slide  
 (c)  both (a) and (b)   
 (d)  none of the above  
  

45.  The sequence of steps to turn off Footer in the Handouts of a PowerPoint presentation is:  
 (a)  Insert >> Header and Footer >> Notes and Handouts >> uncheck Footer  
 (b)  View >> Handout Master >> Placeholders >> uncheck Footer  
 (c)  View >> Notes Master >> Placeholders >> uncheck Footer  
 (d)  View >> Slide Master >> Master Layout >> uncheck Footer  
  

46.  If toggle case font is applied on selected text in a PowerPoint presentation, it will:  
 (a)  convert each capital letter to small and vice versa  
 (b)  convert first letter of each sentence to capital and rest of the letters to small  
 (c)  convert all letters to capital  
 (d)  convert all letters to small  
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47.  While applying the transition effect in a PowerPoint presentation show, you can customize:  

 (a)  speed, sound and color of transition effect  
 (b)  sound, color and direction of transition effect  
 (c)  speed, sound and direction of transition effect  
 (d)  speed, sound, direction and color of transition effect  
    

48.  In a PowerPoint presentation, keyboard shortcut to insert a hyperlink in a slide is:  
 (a) Ctrl + H (b) Ctrl + K  
 (c) Ctrl + L (d) Hyperlinks can’t be inserted in slides  
  

49.  In MS PowerPoint, Screenshot feature can be used to insert a picture of any open window 
that is:  

 (a)  minimized to the task bar  
 (b)  not minimized to the task bar  
 (c)  running irrespective of whether it is minimized or not  
 (d)  running except video applications  
  

50.  Which of the following Picture Styles would NOT be available if a picture is to be inserted in 
a PowerPoint presentation?  

 (a) Beveled Matte, White (b) Simple Triangle  
 (c) Drop Shadow Rectangle (d) Soft Edge Oval  
  

(THE END) 
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